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Chapter 1: Getting Started with 
Image Doctor

Welcome
Welcome to Image Doctor—advanced filters for 
image repair and photo retouching. Use Image 
Doctor to remove objects from textured 
backgrounds, repair textures, repair damaged 
photos, remove blemishes, and perform many 
other photo retouching and restoration tasks.

Please take some time to explore this manual; it 
contains information essential to getting the 
most out of Image Doctor. Take a few minutes to 
familiarize yourself with the preview window 
and user interface, and soon you’ll be ready to 
dive in and experiment with Image Doctor.

This chapter contains the following sections:

• “What’s New” on page 1

• “Important Symbols” on page 2

• “Host Requirements” on page 2

• “System Requirements” on page 2

• “Macintosh Installation” on page 3

• “Windows Installation” on page 5

• “Registering Image Doctor” on page 7

• “The Image Doctor User Interface” on page 7

• “Keyboard Shortcuts” on page 13

• “Finding the Right Image Doctor Filter” on 
page 14

What’s New
Image Doctor is unlike any product Alien Skin 
Software developed previously. Image Doctor 
does not generate flashy eye-catching effects, 
such as bevels, lightning, or chrome. In fact, the 
best application of an Image Doctor effect is 
unnoticeable to the untrained eye. 

Consisting of four all-new image repair utilities, 
Image Doctor contains the following effects:

• Smart Fill—The most powerful image repair 
tool in Image Doctor, Smart Fill seamlessly 
removes and heals large image defects.

• Scratch Remover—An easy-to-use, quick and 
powerful tool for repairing linear defects in 
your image.

• Spot Lifter—Extremely simple tool for quickly 
removing small, round defects in your images. 
Great for all sorts of skin blemishes.

• JPEG Repair—Smooths the blocky artifacts 
associated with highly compressed JPEG 
images. 
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Image Doctor carries on the Alien Skin Software 
tradition of making difficult image editing tasks 
easier and less time consuming, while also 
expanding the capabilities of your image editor.

Image Doctor’s filter-based approach improves 
ease-of-use. Generally, one slider controls the 
repair while related controls blend the repair 
into your image. This clear division of tasks 
streamlines complicated image repair.

Because Image Doctor’s effects are used with 
selections, they repair precisely, and offer more 
control over repair results.

Image Doctor’s tools improve upon standard 
cloning methods; they avoid obvious repetition 
of image detail. In addition, Image Doctor’s 
Smart Fill applies this technology to large defect 
areas.

Image Doctor adds an advanced JPEG restoration 
utility to most image editors.

You'll find these new filters invaluable for 
restoring and retouching your photos.

Important Symbols
Pay close attention when you see a 
warning symbol in the manual. 
Warnings point out bad technique or 
improper use of the Image Doctor 

filters. Don’t shoot yourself in the foot.

Tips provide useful techniques and 
time-saving steps that increase your 
productivity when using Image 
Doctor.

Host Requirements
Image Doctor is a plug-in; you must use it with 
one of the following compatible host programs:

Macintosh
• Adobe Photoshop 5.5 or later

• Macromedia Fireworks 4.0 or later

Windows
• Adobe Photoshop 5.5 or later

• Macromedia Fireworks 4.0 or later

• Paint Shop Pro 6.0 or later

We are constantly testing new programs for 
compatibility with Image Doctor. For infor-
mation about other compatible host programs, 
please check our Web site: 
http://www.alienskin.com.

System Requirements

Macintosh
• PowerPC processor

• Macintosh System Software 9 or later; OS X 
10.1 or later

• 64 MB or more of physical RAM
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Windows
• Pentium II-class processor

• Windows 98/2000/Me/XP
Note: Windows NT is not supported.

• 64 MB or more of physical RAM

Macintosh Installation
The following boxed section contains 
important information about 
installing Image Doctor on systems 
running Macintosh OS X. 

Note: You may skip the following boxed section 
if you are installing on an earlier version of 
Mac OS.

MACINTOSH OS X INSTALLATION ISSUES
Read this section carefully if you are installing 
Image Doctor on systems running Macintosh OS X.

Installing with Administrator Privileges 
To install Image Doctor, your Mac OS X user 
account must have administrator privileges. The 
Image Doctor installer, like most installation pro-
grams, will need to write files to protected folders 
on your computer. For information on configuring 
your user account for administrator privileges, talk 
to your IT guy or consult your operating system’s 
user manual.

Installing Image Doctor as a Classic Application 
If you are running OS X and want to install Image 
Doctor into a host that runs under Classic mode—
such as Photoshop 5.0 or 6.0, for example—you 
will need to make the installer also run under Clas-
sic mode. If the installer runs under OS X, it 
assumes that your host is a Carbonized application 
and saves the registration information differently 
than if you are running under Classic. If you try to 
use Image Doctor in Classic mode, the registration 
information will not be present, you’ll get an error, 
and will be unable to use the filters.

To force the Splat! installer to run in Classic mode, 
highlight the program icon and select Show Info 
under the File menu. Next, check the check box 
item “Open in the Classic environment”. Close the 
Info dialog and double click on the program. This 
will bring up the Classic environment (if it isn’t 
already up) and run the installer.
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Before installing Image Doctor, shut 
down your graphics program 
(Photoshop or Fireworks). This is 
necessary because host programs 

only recognize new filters when starting up. 

Insert the Image Doctor CD into your computer. 
If you purchased an electronic version of 
Image Doctor, locate the Image Doctor instal-
lation program that you downloaded from the 
online store. Double-click the 
“Install Image Doctor” icon. After the splash 
screen, the installer will display the Readme file 
for Image Doctor. Click “Next” after you have 
carefully read the Readme file. The installer will 
then display the License Agreement. After 
reading this, click “Accept”.

Next you will be asked to enter your name, 
company name (optional) and registration code 
in the following dialogue box. 

Your registration code is the 12-letter code 
located on a sticker on the inside front cover of 
the manual. If you purchased an electronic 
version of Image Doctor, the 12-letter code, 
visible during the download process, is included 
in the email invoice or in an electronic users 
license file with your download. We strongly 

suggest you store this code in a safe place for 
future installations. We also recommend regis-
tering the software with Alien Skin Software, 
either via our Web site or by mailing us the 
registration card. If you ever need a replacement 
code, replacement software or require technical 
support, you will need to be registered with us.

After you enter your registration code, you will 
see the main installation screen.

It is important that you now locate your 
graphics program’s plug-in folder. If you do not 
choose the proper plug-in folder, then the filters 
will not show up in your graphics program’s 
Filters menu.

Browse your hard disk until you find the appro-
priate Plug-ins folder. Highlight the folder and 
click the “Choose” button to return to the main 
installation screen. The Image Doctor files will 
be copied to your hard disk.
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If you are not sure where to install Image Doctor, 
consult your graphics program’s manual. 
Photoshop users can check for the plug-in 
location by selecting the Plug-In option under 
the Preferences sub-menu of Photoshop’s File 
menu. The Plug-ins folder is usually located in 
the Photoshop folder.

Rerun the installer if you wish to install 
Image Doctor into other graphics programs.

Windows Installation
The following boxed section contains 
important information about 
installing Image Doctor on systems 
running Windows 2000 and 

Windows XP. 

Note: You may skip the following boxed section 
if you are installing Image Doctor on a Windows 
98 or Windows ME system.

Before installing Image Doctor, shut 
down your graphics program 
(Photoshop, Paint Shop Pro or 
Fireworks). This is necessary because 

host programs only recognize new filters when 
starting up. 

Insert the Image Doctor CD into your computer. 
If you purchased an electronic version of 
Image Doctor, locate the Image Doctor instal-
lation program that you downloaded from the 
online store. Run the program “Setup.exe”. After 
the splash screen, the installer will display the 
Readme file for Image Doctor. Click “Next” after 
you have carefully read the Readme file. The 
installer will then display the License 
Agreement. After reading this, click “Accept”.

WINDOWS INSTALLATION ISSUES

Installing with Administrator Privileges  
To install Image Doctor, your Windows 2000 or 
Windows XP user account will need to have admin-
istrator privileges. The Image Doctor installer, like 
most installation programs, will need to write files 
to protected folders on your computer. For infor-
mation on configuring your user account for such 
privileges, consult with your system administrator 
or with your operating system’s manual.
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Next you will be asked to enter your name, 
company name (optional) and your registration 
code.

Your registration code is the 12-letter code 
located on a sticker on the inside front cover of 
the manual. If you purchased an electronic 
version of Image Doctor, the 12-letter code, 
visible during the download process, is included 
in the email invoice or in an electronic license 
file with your download. We strongly suggest 
you store this code in a safe place for future 
installations. We also recommend registering the 
software with Alien Skin Software, either via our 
Web site or by mailing us the registration card. 

If you ever need a replacement code, 
replacement software or require technical 
support, you will need to be registered with us.

Next, our installer will search for all graphics 
programs on your computer that are compatible 
with Image Doctor and will display them in a 
list.

Select one program (you can only install into 
one graphics program at a time) and click “OK”. 
The installer will look for the correct plug-ins 
folder for the selected program and install Image 
Doctor there. 
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If you wish to install Image Doctor into a 
program that’s not listed in the “Select Host” 
list, click the “Choose Another Location” button 
to bring up the manual “Select Destination 
Directory” window. Browse through the file list 
until you find the desired folder and click “OK”. 
If you are not sure where to install Image Doctor, 
consult your graphics program’s manual. 

Rerun the installer if you wish to install 
Image Doctor into other graphics programs. 

Registering Image Doctor
Please take a moment to register your copy of 
Image Doctor with us. Note that if you 
purchased Image Doctor directly from Alien Skin 
Software, via phone, fax, email or the purchase 

page at our Web site, then you are already regis-
tered with us. You only need to register if you 
purchased Image Doctor through a catalog, store 
or other reseller. Registering will help speed up 
any tech support assistance, and allows us to 
inform you of any bug fixes or updates to the 
software. We’ll also be able to notify you of 
special discounts on other Alien Skin products.

You can register via the World Wide Web during 
the installation process (see either “Macintosh 
Installation” on page 3 or “Windows Instal-
lation” on page 5). 

If you don’t have access to the World Wide Web, 
you can register by completing and mailing the 
registration card included with every hard copy 
of Image Doctor. Mailing the card is free in the 
United States.

The Image Doctor 
User Interface

Menus
Command menus are accessible when you call up 
each of the Image Doctor filters. Macintosh users 
will see the menus in place of their usual menu 
bar. Windows users will see the menus at the top 
of the filter preview window.

Edit Menu
This menu allows you an unlimited number of 
Undo’s and Redo’s in the preview window. If you 
experiment with the sliders, and find that you 
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prefer a previous group of settings, simply use 
the Undo command in the Edit menu, or use 
Command-Z (Control-Z on Windows machines) to 
back up as many times as necessary.

The Edit menu also allows you to Copy, Cut, 
Paste, and Delete numerical values from 
parameter fields.

Filters Menu
This menu allows you to switch between filters 
from within the preview. Photoshop users note 
that if you switch between filters from within 
the Image Doctor preview, the Actions, History, 
and Last Filter Used functions will record the 
filter you initially selected.

View Menu
This menu allows you to zoom the preview in 
and out. You can also view all of the layers in 
your image using the “Show All Layers” 
command. 

Note: Due to a limitation in Photoshop, 
choosing “Show All Layers” in the preview 
window will show all of the visible layers in your 
image, even if those layers are above the current 
(working) layer in the Layers palette. As a 
result, your effect may be invisible in the filter 
preview window.

In the preview, you will also see the current 
working layer below the filter effect. Again, this 
is a limitation in Photoshop, not Image Doctor, 
but it can be misleading so we recommend 

temporarily turning off ‘Show All Layers’ in 
cases where the current working layer is below 
other opaque layers in your composition.

Note: Show All Layers will be grayed out and 
unavailable in hosts other than Photoshop.

Settings Menu
This menu allows you to name, save, and delete 
your own settings, as well as use the presets that 
we include with each filter. You can also reset a 
filter to its factory default settings from this 
menu or by using the F5 key. 

Help Menu
The enhanced Help Menu allows you to access 
context-sensitive (filter-specific) help from 
within a filter window. You can access filter-
specific help by pressing the F1 key within any 
filter interface.

The enhanced Help Menu contains user manual 
documentation and filter tutorials to help you 
better use the Image Doctor filters. You can also 
access the Alien Skin home page from the Help 
menu.

To access a Table of Contents for the online help, 
click Help > Contents in the Image Doctor user-
interface.
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The Filter Window
Take a look at the Macintosh Smart Fill filter 
window. In addition to the filter window, the 
Image Doctor menu bar will appear in place of 
your usual Mac menu bar.

Mac Menu Bar

Windows Menu Bar

Macintosh User Interface

E

B
C

D

F GH

A
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The Windows filter window looks almost exactly 
the same, with the addition of the Image Doctor 
menu bar at the top left.

A: The Slider Controls
Slider controls and radio buttons appear along 
the left side of the filter window. 

Working your way from the top down, 
use the slider controls in their 
order of appearance to simplify 
workflow and get the best results 

with each filter. 

B: Thumbnail Navigation
The thumbnail image above the preview window 
allows you to move the preview anywhere in 
your image with a single click. The movable red 
box displays the area of your image visible in the 
preview window.

C: Move, Zoom, Show Original, and Arrow Buttons
The Move (hand) Zoom (magnifying glass), and 
Show Original tools are found above the 
preview window. Click the hand to enable the 
Move Tool, then click and drag to move around 
the preview image.

The Move and Zoom Tools

Click the magnifying glass to enable the Zoom 
Tool. Click to zoom into your image; Option-click 
to zoom out (Alt-click for Windows users). 
Double-clicking the Zoom Tool at any time resets 
the preview window to 100% magnification.

The Show Original button enables you to toggle 
back and forth between the filtered and unfil-
tered versions of your image. Just click and hold 
the button to view the unaffected image. 
Release the button when you want to view your 
image with the effect.

The Show Original Button

The Arrow button enables control of Texture 
Source Boxes, new in-preview controls essential 
to the Smart Fill filter. See “Texture Source 
Boxes” on page 32 for more information about 
Texture Source Boxes and using the Arrow tool 
in Smart Fill.

The Arrow Button

D: OK and Cancel Controls
Clicking the “OK” button applies the filter with 
the current settings. Clicking “Cancel” closes the 
filter window without applying the effect.

E: Preview Window Area
Preview the effect on your image here. The 
preview area can be resized by clicking and 
dragging the bottom right-hand corner of the 
filter window. Windows users can also click and 
drag the bottom of the window.
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F: Render Status Bar
The rectangle to the left of the magnification 
indicator is the Render Status bar. As an effect 
is being rendered in the preview, this rectangle 
displays the amount of rendering that has been 
completed.

G: Magnification Indicator
The current level of magnification is shown to 
the right of the render status bar at the lower 
right corner of the filter window.

H: Mouseover Help String Area
All elements in each filter window have 
mouseover help text associated with them. This 
help text appears at the bottom left of the filter 
window whenever you move your cursor over a 
user interface element.

A Note About Sliders
A variety of sliders are used in Image Doctor. 
Each one allows you to enter a numeric value or 
click and drag the slider to get the desired 
effect.

Note that you can use the slider, enter a numeric 
value, or use the up and down arrow keys to 
change the value of filter controls. You can also 
adjust slider settings by using the up and down 
arrow buttons to the right of the sliders.

Using Settings
The Settings menu in each filter window allows 
you to save and manage the presets that are 
included with each filter. You can also create 
your own settings.

Note: In Image Doctor, slider combinations that 
work well tend to be image or even selection-
specific. Hence, settings do not travel well. Do 
not expect a great combination of settings 
applied to one image to work well on another. 

How to load a preset
To use a preset included with a filter, simply 
open the “Settings” menu and select the name 
of the desired setting from the list.

How to Save and Manage Settings
If you have a filter setting you’d like to save for 
later use, click “Save...” in the Settings menu. A 
dialog box appears, asking you to name the 
setting. Type in a name, using only letters 
and/or numbers, and click “OK”. The setting will 
appear in the Settings menu immediately.

To rename a setting, click “Manage...” in the 
Settings menu. Highlight the setting you wish 
to edit and click “Rename”. Type in the new 
name and click “OK”.

To delete a setting, click “Manage...” in the 
Settings menu. Highlight the setting you wish 
to delete from the list and click “Delete”.

You will not be able to “undo” deleting a setting. 
Be certain you want to delete any setting before 
doing so; the delete is permanent.



12
Resetting to Factory Default
Every filter has a basic factory default setting. 
The Reset to factory default command in the 
Settings menu will display a preview with the 
filter’s default setting. If you are bogged down 
in a quagmire of complex slider combinations, 
use the F5 key to reset the current preview to 
the filter’s factory default setting. 

Using the Right Selection 
Tools in Image Doctor
Unlike previous Alien Skin Software filters, 
Image Doctor should always (except for the JPEG 
Repair filter) be used with selections. 

Avoid using the geometric selection 
tools, such as the marquee selection 
tool in Photoshop. So that your 
repairs are less noticeable, use 

precision selection tools, such as the lasso or 
magnetic lasso tool.
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Keyboard Shortcuts

Macintosh Windows

Next Slider Field Tab Tab

Previous Slider Field Shift + Tab Shift + Tab

OK Return Return

Cancel Escape Escape

Undo Command-Z Control-Z

Redo Command-Y Control-Y

Cut Command-X Control-X

Copy Command-C Control-C

Paste Command-V Control-V

Next Filter Command- ] Control- ]

Previous Filter Command- [ Control- [

Zoom In Command- + Control- +

Zoom Out Command- - Control- -

Actual Pixels Command-zero Control-zero

Restore Default Settings Command-R F5

Switch to Move Mode (hand) H H

Switch to Zoom Mode Z Z

Switch to Adjustment Mode A A

Zoom In (with zoom enabled) Mouse Click Left Mouse Click

Zoom Out Option + Mouse Click Alt + Mouse Click

Zoom to Actual Pixels Double-click Zoom Tool Double-click Zoom Tool

Increase/Decrease Slider by 1 Up/Down Arrow Up/Down Arrow

Increase/Decrease Slider by 10 Shift-Up/Down Arrow Shift-Up/Down Arrow

Snap Texture Source Box (15 degree incre-
ments)

Hold Shift Key then Click and Drag Source 
Frame Arrow

Hold Shift Key then Left-click and Drag 
Source Frame Arrow
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Finding the Right Image Doctor Filter
Each Image Doctor filter is designed to handle specific repair situations. The table below will help you 
find the filter best suited to a particular image repair job. Sometimes, there are overlaps in filter 
functionality. In these cases, you may wish to experiment with both filters to determine which one 
gives you the best results.

Type of Repair JPEG Repair Scratch Remover Smart Fill Spot Lifter

Repairing Badly Compressed Images X

Repairing Tears X

Repairing Cracks X

Repairing Rips X

Removing Scratches X

Removing Creases or Folds X X

Removing Small Objects from an 
Image

X X

Removing Wrinkles X X

Removing Zits/Blemishes/Moles X X

Removing Large Objects from an 
Image

X

Removing/Adding Texture X

Restoring Textures X

Restoring Skin Texture X

Repairing Textures X

Removing Stains X X

Removing Shadows Under Eyes X

Removing Dust X

Removing Mold X
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Enjoy the Filters!
That’s it for the opening section. We’ve designed 
Image Doctor to be a tool that’s both fun and 
easy to use. We hope you enjoy using the filters.
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Chapter 2: JPEG Repair

JPEG compression separates an image into 8x8 
(pixel) rectangles, then independently 
compresses each rectangle. The result of a poor 
use of JPEG compression is an ugly, repetitive 
pattern of blocks. Over-compression can take 
place when an image is saved as a JPEG in 
computer software, like Photoshop, or when an 
image is snapped at low-resolution in hardware, 

like a digital camera. JPEG Repair reduces the 
damage caused by over-compressing screen-
resolution JPEG image files, making damaged 
images more aesthetically pleasing.

Note: It is impossible to restore details from the 
original uncompressed image—details that were 
lost in the compression process. JPEG Repair 
reduces the visual impact of over-compression.

before

after
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This chapter contains the following sections:

• “Using JPEG Repair” on page 18

• “Slider and Button Descriptions” on page 18

• “Tutorials” on page 19

• “Tips and Tricks” on page 21

Using JPEG Repair
Use the following procedure to use JPEG Repair:

1 Select the area to be repaired.

2 Starting from the lowest setting, increment 
the Remove Artifacts slider until the percep-
tible blocky defects of JPEG compression have 
been removed. Do not overuse.

3 If even the strongest Remove Artifacts settings 
do not remove all of the blocky artifacts, use 
just enough “Blur Edges” to remove the 
remaining artifacts.

4 Use the “Add Grain” slider to add back any 
surface detail lost during Steps 2 and 3. Use 
only as much grain as needed.

Slider and Button 
Descriptions
Remove Artifacts This slider controls the 
strength of “deblocking” in JPEG Repair—the 
reduction of rectangle-shaped artifacts in highly 
compressed JPEGs. Moving the slider to the right 
strengthens the deblocking effect. You might 
assume that selecting the highest value would 
give you the best results. This, however, is not 

the case. Excessive “Remove Artifacts” values 
result in an unnaturally soft appearance in your 
image. Don’t smear too much Vaseline on the 
lens. Use only as much artifact removal as 
necessary.
Range: 1 – 100

Blur Edges This slider controls the amount of 
blur apparent on the discrete edges within your 
selection. Moving the slider to the right 
increases the amount of blur applied. Some blur 
can help wipe out defects, such as extra 
stubborn artifact edges. Too much can wipe out 
all detail from your image. Use Blur Edges 
cautiously.
Range: 1 – 20

Add Grain JPEG Repair introduces subtle, 
organic noise—randomly placed blobs in your 
image or selection that help recreate the organic 
surface textures of higher-resolution, un-
compressed images. Moving the slider to the 
right yields a stronger pattern of dark blobs. 
Again, only use as much as needed to get the 
best results.
Range: 0 – 20

Randomize Grain To instantly change the 
arrangement of grain added to your selection, 
click this button. If the “Add Grain” slider is set 
to 0, the “Randomize Grain” button is disabled.
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Tutorials

Using Multiple Selections to Repair a JPEG
Sometimes, JPEG compression artifacts seem perceptibly stronger in different areas within an image. 
It is best to separately select and filter these areas. By treating all damaged areas the same, you risk 
losing detail in the less damaged areas of your image.

Use the following procedure to get the best results when using multiple selections.

1 Identify the areas of your image containing visually similar damage. The image below provides a 
simple example of how damage can look different in parts of an image. In this picture, the yolks 
exhibit more damage than the whites.

More Damage

Less Damage
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2 Select one of the visually similar areas.
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3 Perform JPEG Repair on this selection and click OK.

4 Repeat steps 2 and 3 until you have removed the JPEG artifacts from your image.

Tips and Tricks

Do Not Crop or Resize Your Image 
Before Using JPEG Repair
JPEG Repair relies on the 8x8 pixel 

regularity of the JPEG compression grid. 
Cropping or resizing your image will limit the 
effectiveness of the filter. Use JPEG Repair first, 

then crop or resize.

Using JPEG Repair with Selections
You can use JPEG Repair with or 
without a selection, but we suggest 

using selections to separately treat the areas in 
your image with perceptibly different levels of 
damage. For example, skin may exhibit stronger 
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artifacts than hair. Applying the same strength 
of repair to the entire image may wash out some 
details that you wish to preserve in the hair. In 
this case, you should select and treat the hair 
first, then repeat the procedure on the skin-
toned areas.

Do Not Overuse JPEG Repair
JPEG Repair is extremely easy to use. With only 
three sliders to adjust, it’s hard to screw up. It’s 
also an easy filter to overuse. Use it only as much 
as necessary to prevent creating an “airbrushed” 
appearance in your repaired image.
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Chapter 3: Scratch Remover

Scratch Remover offers the quickest answer to 
texture repair and defect removal in 
Image Doctor. Scratch Remover is a simpler-to-
use counterpart to the more elaborate Smart Fill 
filter, and should be used to clean up minor 
texture defects placed in fairly homogenous 
surrounding textures. Use it primarily for elimi-
nating linear defects such as tears and creases or 
to remove small text, such as time stamps, 
subtitles, or logo text from images.

Scratch Remover samples textures from areas 
surrounding your selection and recombines 
them inside your selection to organically repair 
images. This avoids the repetitive patterns that 
result from directly cloning source textures. 

This chapter contains the following sections:

• “Using Scratch Remover” on page 23

• “Slider Descriptions” on page 24

• “Tutorials” on page 25

• “Tips and Tricks” on page 27

Using Scratch Remover
To use Scratch Remover:

1 Select the area to be repaired.

before

after
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2 Adjust the “Texture Feature Size” slider to 
approximately match the size of the details in 
the image surrounding the repair area. See the 
“Texture Feature Size” section for detailed 
information on using this slider.

3 Select the Texture Regularity setting that 
yields the most seamless match between the 
repaired area and the surrounding region.

4 Click the “Regenerate Texture” button a few 
times, until you find the best match result.

5 Repeat steps 2 through 4, if necessary, and 
click “OK.”

Slider Descriptions
Contract or Expand Selection (pixels) Use this 
slider to contract or expand your original 
selection from within the Image Doctor 
interface.
Range: -20 – (20)

Why? If the initial preview reveals remnants of 
your original selection, you can expand your 
selection to knock out the leftovers. If you find 
that you are removing some nearby desirable 
image detail, you can contract your selection a 
couple of pixels to protect that area. It’s best to 
make a good, close selection before you run the 
filter, however.

Texture Feature Size Use this slider to specify the 
texture sample size that Scratch Remover uses 
for texture replacement. If, for example, the 
blades of grass that make up the sampled 

texture are roughly 15 pixels tall, pump up the 
feature size to about 15 pixels. 
Range: 3 – 30

Texture Regularity These radio buttons control 
how closely Scratch Remover matches the image 
details generated in your selection. For more 
predictable textures, such as bricks, use higher 
values. For irregular patterns, such as grass, 
sometimes lower values will do just fine. Using 
lower Texture Regularity values helps the filter 
render faster and randomizes the appearance of 
image details generated in your selection.
Options: Low, Medium, High

Feather Radius Feather Radius creates an opacity 
drop off around the edge of the affected area of 
your image—helping blend the filtered area 
with the surrounding unaffected pixels. 
Range: 0 - 4 pixels.

Feathering can cause an unnatural 
loss of detail at the edge of your 
selection if used in excess.

Regenerate Texture Use this button to randomly 
rearrange the fill details generated by Scratch 
Remover. In many cases, you can simply run the 
Scratch Remover filter, click 
“Regenerate Texture” a few times, and get great 
results. 
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Tutorials

Removing Time Codes from Photos or Video 
Captures
Removing time codes from photos and video 
captures is a snap with Image Doctor. We suggest 
that you use the following steps to obtain the 
best results.

1 Use the magic wand tool to select a single 
character at a time.

Continued on the next page
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2 Run Scratch Remover. 

3 Adjust the “Contract/Expand Selection” slider 
until all traces of the character have been 
affected.

4 Use the Texture Feature Size, Regenerate 
Texture button, and Feather Radius slider until 
you are satisfied with the background 
replacement.

5 Click “OK”.

6 Using the magic wand, select the next 
character.

7 Click Control-F, to rerun Scratch Remover with 
the same slider parameter combination.

8 Repeat Steps 5 and 6 until you have 
completely removed the time code. 

Note: Keep an eye on your results. Generally, 
the first attempt works just fine; occasionally, 
however, you may need to open the filter 
interface and tweak the sliders to completely 
remove a character.
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Here’s your result.

Tips and Tricks

Using Selections
Great image corrections start with 
good selections. Try to get a selection 

that includes your defect and only your defect. 
Specifically, we recommend that you do not use 
a geometric selection tool, such as Photoshop's 
Marquee tool to make your selections. Instead, 
Photoshop users can use the Lasso tool.

Using Multiple Selections on 
Defects Spanning Different 
Background Textures

To get the best results, divide your work into 
sections when a defect spans several visually 
different areas. In the example at the beginning 
of the chapter, a total of six selections were used 
to get the best result.

Selections

Selections
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Removing Large Quantities of 
Similar Defects
When removing a large number of 

similar defects from an image, use the following 
technique to speed up your work:

• Run the filter on an individual defect.

• Select the remaining defects.

• Use the filter 'redo' key (CTRL-F in Photoshop) 
to quickly remove the remaining defects.
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Chapter 4: Smart Fill

Use Smart Fill to remove large objects from 
images with complex background details. Smart 
Fill is unique; rather than directly cloning parts 
of an image, the filter intelligently samples 
image chunks around the area to be removed, 
automatically detects details such as color and 
lighting, then recombines the sampled image 
details to create a contiguous background 
texture where the original object once appeared. 

This chapter contains the following sections:

• “Using Smart Fill” on page 30

• “Slider Descriptions and In-Preview Controls” 
on page 30

• “When to Use Stitching or Feathering” on 
page 31

• “Tutorials” on page 33

• “Tips and Tricks” on page 42

before after
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Using Smart Fill
1 Using a selection tool, preferably the lasso, 

make a selection around the defect or object 
that you want to remove.

2 Run the Smart Fill filter.

3 Click the Arrow button to view and adjust the 
Texture Source Box control. Most of the time, 
placing a Texture Source Box directly around 
the area of the selection will do the trick. 
Sometimes, however, you may wish to sample 
a texture from another location in the filter 
preview. In this case, click and drag the spot 
in the center of the texture source box to the 
desired location in your image. For more infor-
mation on using Texture Source Boxes, see the 
“Texture Source Boxes” section in this chapter.

4 Adjust the Contract or Expand Selection slider 
to make sure you have completely selected the 
the object you wish to remove.

5 Adjust the Texture Feature Size slider to 
sample appropriately sized image details. See 
“Texture Feature Size” on page 30 for more 
information.

6 Adjust Texture Regularity to taste. See 
“Texture Regularity” on page 30 for more 
information.

7 Click Regenerate Texture a few times to 
randomize the resulting fill pattern. In many 
cases, you can simply run the Smart Fill filter, 
click “Regenerate Texture” a few times, and 
get great results. 

Slider Descriptions and In-
Preview Controls
Contract or Expand Selection (pixels) Use this 
slider to contract or expand your original 
selection from within the Image Doctor 
interface. 
Range: -20 – (20)

Why? If the initial preview reveals remnants of 
your original selection, you can expand your 
selection to knock out the leftovers. If you find 
that you are removing some nearby desirable 
image detail, you can contract your selection a 
couple of pixels to protect that area. It’s best to 
make a good, close selection before you run the 
filter, however.

Texture Feature Size Use this slider to specify 
the texture sample size that Smart Fill uses for 
texture replacement. If, for example, the blades 
of grass that make up the sampled texture are 
roughly 15 pixels tall, pump up the feature size 
to about 15 pixels.
Range: 3 – 100

Note: The Feature Size slider works in 
conjunction with the hash marks in the Texture 
Source Box in-preview control. When you 
increment the feature size slider, the hash marks 
spread apart to reflect the increasing size of 
texture chunks being sampled. 

Texture Regularity These radio buttons control 
how closely Smart Fill matches the image details 
generated in your selection. For more 
predictable textures, such as bricks, use higher 
values. For irregular patterns, such as grass, 
sometimes lower values will do just fine. Using 
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lower Texture Regularity values helps the filter 
render faster and randomizes the appearance of 
image details generated in your selection.
Options: Low, Medium, High

Stitch into Background Selecting this box 
forces Smart Fill to attempt a seamless 
placement of fill textures in your selected area.

Note: Checking this box disables the 
“Feather Radius” slider.

Feather Radius Feather Radius creates an 
opacity drop off around the edge of the affected 
area of your image—helping blend the filtered 
area with the surrounding unaffected pixels. To 
use stitching, clear the “Stitch into Background” 
check box. See “When to Use Stitching or Feath-
ering” for detailed information on the subject. 
Range: 0 - 4 pixels.

Feathering can cause an unnatural 
loss of detail at the edge of your 
selection if used in excess.

Regenerate Texture Use this button to 
randomly rearrange the fill details generated by 
Smart Fill. In many cases, you can simply run 
the Smart Fill filter, click “Regenerate Texture” 
a few times, and get great results.

When to Use Stitching or 
Feathering 
This section provides detailed information on 
how to properly use the “Stitch into 
Background” and “Feather Radius” controls.

Stitching and Feathering: How they Differ
“Stitch into Background” analyzes the 
appearance of image details that surround your 
selection and attempts to match the edges of 
the composite fill image to those details. 
Stitching almost always provides the best Smart 
Fill results.

“Feather Radius” specifies an opacity drop-off (1 
to 4 pixels) around the outside of your selected 
fill area and the surrounding image detail. 
Feathering disables stitching, however, usually 
with results inferior to those produced by 
stitching.

Always Try Stitch into Background First
Stitch into Background is the best option for 
seamlessly removing objects from a background. 
If you are not getting the desired result, try the 
following steps, before using feathering, to 
improve the quality of your fill results.

• Expand your texture source box.

• Reduce the “Feature Size” slider value.

• Use a precise selection tool, such as the lasso.

• Use multiple selections when the object you 
wish to remove traverses multiple different 
backgrounds. 

• Rearrange the fill details in your selection by 
clicking “Rearrange Texture”.
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When to use Feather Radius
When a selection falls on a sharply contrasting 
edge, such as a horizon behind a desert 
landscape, stitching can introduce a rough edge. 
Feathering can help soften these edges. 

Stitching writes outside of your selection. 
Sometimes, as a result, Smart Fill overwrites 
parts of an image you wish to preserve. If you 
want to preserve the areas outside of your 
selection, use feathering.

In-Preview Controls

Texture Source Boxes
Texture Source Boxes specify the areas from 
which Smart Fill samples the small image details 
used to remove an object. 

Texture Source Box

Hash Marks The hash marks on your texture 
source control box expand and contract as you 
adjust the Texture Feature Size slider. 

Arrow Button

Click the Arrow button to control the placement, 
size, and inclination of Texture Source Boxes in 
Smart Fill. Click and drag any corner of a Texture 
Source Box to resize it. Click and drag the spot 
in the center of the box to move it. Click and 
drag the triangle above the box to rotate the 
box.

Arrow Button

Note: Rotating the Texture Source Box rotates 
the angle at which fill details will appear in your 
image. Rotation is rarely needed, but can be 
useful in cases where you are sampling image 
details far from the object that you are 
removing. In far off locations, the perspective of 
sampled image details may differ. 

Using Multiple Texture Source Boxes If you are 
trying to fill an area with image details that 
exist in various parts of an image, use more than 
one Texture Source Box. To initialize a new 
Texture Source Box, click any part of your 
preview image using the Arrow tool. 

Deleting Texture Source Boxes To delete a 
Texture Source Box, click and drag it out of the 
preview area.
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Tutorials

Simple Object Removal
Use this tutorial to learn how to remove an object from an uninterrupted, homogenous background 
texture.

We begin with a bottle lying in a background texture of grass.
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1 Using virtually any selection tool, preferably 
the lasso, make a rough selection around the 
object that you wish to remove.
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2 Run Smart Fill.

3 Click on the in-preview Arrow control to adjust 
your Texture Source Box. 

Note: Clicking and dragging any corner resizes 
the frame. Clicking and dragging the dot in the 
center of the frame moves the frame around 
the interface. The bottle will not be sampled. 
Smart Fill ignores any selected pixels inside of 
the Texture Source Box.

4 Center the frame around the bottle and resize 
to sample a generous amount of the 
surrounding background texture.

5 Adjust the Texture Feature Size slider to match 
the physical characteristics of the background 
texture. In this example, blades of grass are 
about 50 pixels long.

Note: The hash marks on your texture source 
control box expand and contract as you 
change Texture Feature Size. 
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6 Try the Texture Regularity radio buttons to 
and see which one works best.

Note: For less complex background textures, 
such as concrete, sand, or asphalt, a low 
Texture Regularity would work just fine.

7 Select the “Stitch Into Background” check box 
to seamlessly place the sampled grass swatches 
into the selected area. If the stitching effect 
leaves a rough edge, click the 
“Regenerate Texture” button a few times. If 
you still can’t get the desired effect, clear 
“Stitch into Background” and try using feath-
ering to soften the effect edge. 

Note: “Stitch into Background” is the best way 
to generate a seamless fill texture in your 
selection. For the most “invisible” result, 
stitching is nearly always preferable to feath-
ering.

8 Preview your results. If they are close but not 
quite perfect, click the “Randomize Texture” 
button a few times until you get the best 
result.
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9 When you are satisfied with the preview, click 
OK.

The final result
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Using Multiple Selections to Remove Objects 
from Complex Backgrounds
Sometimes an object or defect you wish to 
remove will overlie several different background 
textures such as in the fire hydrant example 
below.

The fire hydrant stands in front of two distinct 
background textures: bushes and mulch.

To get the best results when removing the fire 
hydrant, use two selections, with the selection 
boundary between the two located roughly 
between the bushes and mulch.

Use the procedure starting on page 39 to remove 
defects or objects from complex backgrounds.

Selection 1
Bushes

Selection 2
Mulch and weeds
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1 Select the upper part of the fire hydrant using 
the lasso tool.

2 Run Smart Fill.
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3 Click on the in-preview Arrow control to adjust 
your Texture Source Box.

4 Make sure the frame is positioned to sample a 
generous amount of the bush texture.

5 Adjust the Texture Feature Size slider to match 
the physical characteristics of the background 
texture. 

Note: The hash marks on your texture source 
control box expand and contract as you 
change Texture Feature Size. 

6 Try the Texture Regularity radio buttons to 
and see which one works best.

Note: For less complex background textures, 
such as concrete, sand, or asphalt, a low 
Texture Regularity would work just fine.

7 Select the “Stitch Into Background” check box 
to seamlessly place the sampled bush swatches 
into the selected area. If the stitching effect 
leaves a rough edge, click the 
“Regenerate Texture” button a few times. If 
you still can’t get the desired effect, clear 
“Stitch into Background” and try using feath-
ering to soften the effect edge. 

Note: “Stitch into Background” is the best way 
to generate a seamless fill texture in your 
selection. For the most “invisible” result, 
stitching is almost always preferable to feath-
ering.

8 Preview your results. If they are close but not 
quite perfect, click the “Randomize Texture” 
button a few times until you get the best 
result.

9 Click OK.

10 Select the lower part of the fire hydrant 
using the lasso tool.
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11 Run Smart Fill.

Continued on the next page.
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12 Repeat Steps 3-9. Here’s your result!

Tips and Tricks
The following tips will help you get the best 
results when using Smart Fill.

Use Multiple Selections to Remove 
Objects from Complex Backgrounds
When you wish to remove an object 

that traverses several different background 
textures, you should you use multiple selections 
and applications of Smart Fill to get the best 
effect. The fire hydrant example at the 
beginning of this chapter required two separate 
selections and applications of Smart Fill to get 
the best result.

Using Smart Fill on Long or 
Narrow Selections
With long or narrow objects (like a 

car or phone booth), dividing your work into 
small selections gives you more control and 
better results when using Smart Fill—especially 
if the object you are removing lies on a 
background of multiple textures—grass, 
asphalt, and dirt, for example. 

When applying Smart Fill to long objects, it’s 
best to start by selecting the left most part of 
the object and then work toward the right. With 
tall objects, start at the top left and work your 
way down. Because of the way Smart Fill 
analyzes a selection, this method will result in 
the best fill quality.

Making Good Selections
Great image corrections start with 
good selections. Try to get a selection 

that includes only the defect you wish to 
remove. Specifically, we recommend that you do 
not use a geometric selection tool, such as 
Photoshop's Marquee tool to make your selec-
tions. Instead, Photoshop users should use the 
Lasso tool.
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Chapter 5: Spot Lifter

Spot Lifter is the quickest and easiest way to 
remove small, low-contrast defects from images, 
while blending in the appearance of the 
surrounding image. It works great for cleaning 
up all sorts of skin blemishes, such as acne, 
freckles, moles, and shadows under the eyes. 
Spot Lifter also removes small water stains, mold 
spots, or any other softly-colored, low-contrast 
defect from a relatively smooth background 
texture.

Note: If you can not get the results you want 
from Spot Lifter, use Scratch Remover or Smart 
Fill for more advanced object removal in 
Image Doctor.

This chapter contains the following sections:

• “Using Spot Lifter” on page 43

• “Slider Descriptions” on page 44

• “Tutorials” on page 44

• “Tips and Tricks” on page 46

Using Spot Lifter
1 Using the Lasso tool, select the area around 

the spot that you want to remove. Try to select 
an area as close as possible to the spot, but 
make sure you select the entire defect.

2 Run Spot Lifter.

3 Adjust the Contract or Expand Selection slider 
to make sure you are removing all of the 
defect, without unnecessarily removing any 
extra image detail around the selection.

4 Starting with a value of 100, adjust the 
Removal Strength slider. Try to use this slider 
only as much as necessary. Extremely high 
values can completely blur the authentic 
texture the filter-affected area.

5 Click OK.

before

after
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Slider Descriptions
Contract or Expand Selection (pixels) Use this 
slider to contract or expand your original 
selection from within the Image Doctor 
interface. 
Range -20 – (20)

Why? If the initial preview reveals remnants of 
your original selection, you can expand your 
selection to knock out the leftovers. If you find 
that you are removing some nearby desirable 
image detail, you can contract your selection a 
couple of pixels to protect that area. It’s best to 
make a good, close selection before you run the 
filter, however.

Removal Strength This slider controls the 
strength of defect removal in Spot Lifter. 
Starting from 100, you should lower Removal 
Strength value until you get the desired amount 
of blemish removal, while preserving a natural 
appearance that blends smoothly into the 
surrounding unaffected texture. 
Range: 1 – 100.

Why not always use 100? The highest value of 
Removal Strength completely blurs the texture 
that replaces your defect, and may yield an 
unnaturally smooth or polished texture.

Feather Radius Feather Radius creates an opacity 
drop off around the edge of the affected area of 
your image—helping blend the filtered area 
with the surrounding unaffected pixels. 
Range: 0 - 4 pixels.

Feathering can cause an unnatural 
loss of detail at the edge of your 
selection if used in excess.

Tutorials

Removing Shadows and Bags Under Eyes
A great use for Spot Lifter in portrait photog-
raphy is the reduction of shadows and bags 
under the eyes. Spot Lifter removes shadows and 
puffiness without removing the realistic texture 
of the skin. Use the following procedure to 
remove bags from your facial portraits.

1 Find a photo of somebody with a killer 
hangover, such as the poor guy from the 
beginning of the chapter.

2 Using the lasso tool, select the swollen area 
under the eye.

3 Launch Spot Lifter.

4 If you have not selected the entire area, 
increment the “Expand/Contract Selection” 
slider until you have removed the entire area.
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Note: Be careful not to expand too far. You 
don’t want to affect anything outside of the 
bags under the eyes.

Conversely, if you have selected an inappropri-
ately large area, decrease the slider until you 
have affected only the puffy area.

5 Experiment with the “Feather Radius” slider. 
In some cases, feathering isn’t necessary. In 
this tutorial, I achieved the best results with 
no feathering at all.

6 Click OK to apply the filter to the first 
selection.

7 Using the lasso tool, select the swollen area 
starting below the right corner of the left eye 
and work your way around the area.

8 Repeat steps 4 and 5.

9 Experiment with the “Feather Radius” slider. 
In some cases, feathering isn’t necessary. In 
this tutorial, I achieved the best results with 
no feathering at all.
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10 Click OK to apply the filter. Here’s your 
result!

Tips and Tricks

Do Not Overuse Removal Strength
Overusing removal strength will yield 
a completely blurred selection, 

wiping out any realistic surface texture.

Removing Large Quantities of 
Similar Blemishes
When removing a large number 

similar facial blemishes or small defects from an 
image, use the following technique to speed up 
your work:

• Run the filter on an individual blemish.

• Select the remaining blemishes.

• Use the filter 'redo' key (CTRL-F in Photoshop) 
to quickly remove the remaining spots.
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Chapter 6: Troubleshooting

We have tried to collect the most commonly-
asked questions here. A regularly updated 
troubleshooting guide can be found in the 
Support section of our Web site. If you get really 
stuck, the best way to get help is to send E-mail 
to support@alienskin.com. Include in the E-
mail your 12 letter registration code, whether 
you are using Mac or Windows, and your 
graphics host program (Photoshop, Paint Shop 
Pro, etc.).

This chapter covers the following trouble-
shooting issues:

• “Installation Problems” on page 47

• “Performance Issues” on page 49

• “Error Messages” on page 51

Installation Problems
Problem: The installer program is asking for a 
Product Registration Code, and I can’t find such 
a code.

Solution: The Product Registration Code is a 12-
letter code located either on the inside cover of 
your manual, on the CD jewel case or, if you 
received an electronic version of the software, in 
an E-mail invoice or electronic user license text 
file. If you’ve registered the software with us (by 
purchasing directly from us, registering online, 
or sending in a registration card), we’ll have the 
code in our database. If you didn’t register with 
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us, contact us regarding how to provide proof of 
purchase in order to get registered and receive a 
new code.

Problem: When I try to install Image Doctor, I 
get an error dialog saying that I don’t have 
privileges or permission to install the software.

Solution: The Image Doctor installer, like most 
installation programs, will need to write files to 
various folders on your computer. With 
operating systems such as Mac OS X, Windows 
2000 and Windows XP, you will need to have 
administrator privileges. For information on 
configuring your user account for such privi-
leges, consult with your system administrator or 
with your operating system manual.

Problem: After installing the plug-ins and 
starting the graphics host program, the filters 
do not appear in the Filter or plug-in menu.

Solution: The filters were probably not installed 
in your graphics program’s plug-in folder. Find 
out exactly which folder your host program is 
using for plug-ins. With Photoshop, you can 
determine this by going to File > Preferences > 
Plug-ins. Then try to install the filters again and 
make sure you select the proper plug-in folder. 
Also, remember that after installing new filters, 
you must restart your graphics program for them 
to become available. With other graphic host 
programs, consult that program’s manual for 
more information about where plug-ins need to 
be installed and how to access them.

Solution for Fireworks 4.0 (Macintosh): Image 
Doctor’s plug-in file contains both a Classic and 
a Carbonized version of the filters. This is called 
a “package.” Fireworks 4.0 doesn’t quite know 
how to handle such a plug-in. Hence, you’ll need 
to do some tweaking to get Image Doctor 
working under Fireworks 4.0. 

First, drag the Image Doctor plug-in and help 
files out of the Image Doctor folder and place 
them in the Xtras folder. Fireworks 4.0 has 
problems reading the plug-in files when they are 
in the Image Doctor folder.

Next, Ctrl-click the Image Doctor plug-in file 
icon. Select the option “Show Package Contents” 
in the menu. Open the Image Doctor package, 
and you should see a Contents folder. Open that 
folder and you’ll see the MacOS and MacOSClassic 
folders. Drag the MacOS folder into the Trash. 
Now you’ll be able to use Image Doctor in 
Fireworks 4.0.

Problem: I see filters listed twice in Fireworks 
4.0.

Solution: Image Doctor’s plug-in file contains 
both a Classic and a Carbonized version of the 
filters. This is called a “package.” Fireworks 4.0 
doesn’t quite know how to handle such a plug-
in. Hence, you’ll need to do some tweaking to 
get Image Doctor working under Fireworks 4.0.

Next, Ctrl-click the Image Doctor plug-in file 
icon. Select the option “Show Package Contents” 
in the menu. Open the Image Doctor package, 
and you should see a Contents folder. Open that 
folder and you’ll see the MacOS and MacOSClassic 
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folders. Drag the MacOS folder into the Trash. 
Now you’ll be able to use Image Doctor in 
Fireworks 4.0.

Problem: Image Doctor doesn’t work with a 
graphics program that claims to use Photoshop 
plug-ins.

Solution: Programs sometimes claim to work 
with all Photoshop plug-ins without testing 
thoroughly or strictly following the Photoshop 
plug-in standard. If you’d like to use 
Image Doctor with a host not listed in this 
manual, please visit our Web site for the latest 
list of compatible hosts.

Problem: How do I uninstall Image Doctor?

Macintosh Solution: Find the Image Doctor folder 
in your graphics program’s plug-in folder and 
delete it. Also delete the 
Application Support: Alien Skin: 
Image Doctor folder.

Windows Solution: Run Add/Remove Programs 
from your Windows Control Panel. Select 
“Image Doctor” from the program list and click 
the “Add/Remove” button. This will remove the 
program and most of its components. Next go to 
your plug-ins folder and delete the 
“Image Doctor Settings” folder.

Performance Issues
Problem: some or all of the filters appear grayed 
out in the Filter menu.

Solution: Grayed-out filters in the Filter menu 
occur if you are in certain color modes (such as 
CMYK, Lab or Bitmap) that won’t allow a specific 
filter to work properly.

Problem: Smart Fill seems to run very slow.

Solution: Smart Fill analyzes a selection for 
texture samples, then reconstructs them into a 
seamless randomized texture. As the texture 
regularity or the size of your selection increases, 
so does the time necessary for the filter to 
render its effect. To remedy this problem, select 
a lower texture regularity or divide your work 
into multiple selections.

Also, large or multiple texture source boxes can 
slow Smart Fill. To speed up the filter, use 
smaller, fewer, or more selective texture source 
boxes.

Problem: One of the filters seems to have no 
effect on the image.

Solution: You may have a layer selected that is 
hidden by other layers with “Show all Layers” 
enabled in your filter preview. 

Problem: I get a message that Image Doctor ran 
out of memory while rendering the preview.

Solution: Image Doctor works within the 
memory allocated to Photoshop. If Photoshop’s 
memory is being taken up by the image, the 
history palette, etc., there may not be enough 
memory for Image Doctor to draw its preview or 
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render the effect. The solution is to exit our 
filter, save your image and do the following 
steps…

For Windows: With Photoshop 5.5 or later, a lot 
of memory can be taken up with the history 
palette and other features. You can free up this 
memory by selecting Edit > Purge > All from the 
Photoshop menu.

For Macintosh OS X: Use the Windows solution.

For Macintosh OS 9: You can increase the memory 
allocation by exiting Photoshop and performing 
a Get Info on the Photoshop program icon. With 
Photoshop 5.5 or later, a lot of memory can be 
taken up with the history palette and other 
features. You can free up this memory by 
selecting Edit > Purge > All from the Photoshop 
menu.

Problem: The preview seems broken. It only 
shows the checkerboard pattern.

Solution: Sometimes the preview begins in a 
transparent part of a layer. Click an opaque area 
of your selection in the navigation thumbnail.

Problem: A filter makes the graphics program or 
the entire computer crash or freeze up.

Macintosh Solution: Make sure that you have 
allocated enough memory to Photoshop. The 
default memory allocation may not be enough, 
especially if you are working with print 
resolution images. You can increase the memory 
allocation by exiting Photoshop and performing 
a Get Info on the Photoshop program icon. 

To determine whether you have an extension 
conflict, restart your computer while holding 
down the Shift key. You may release the Shift 
key after you see the message “Welcome to 
Macintosh. Extensions off.” Then try the same 
filter operation. If it now works, then you have 
a control panel or extension installed in your 
computer that is incompatible with 
Image Doctor. We will love you very much if you 
try to identify the problem extension and 
inform us of the conflict.

Windows Solution: Make sure that you have 
allocated enough memory to Photoshop. The 
default memory allocation may not be enough, 
especially if you are working with print 
resolution images. With Photoshop 5.5 or later, 
a lot of memory can be taken up with the history 
palette and other features. You can free up this 
memory by selecting Edit > Purge > All from the 
Photoshop menu.

Also, make sure that your computer system has 
the minimum requirements to run our software. 
You also should try exiting out of other 
programs before you run Photoshop, as there 
might be a conflict between another program 
and Image Doctor If you notice such a conflict, 
we will love you very much if you try to identify 
the problem program and inform us of the 
conflict.
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Error Messages
The table below provides remedies to the error messages you may encounter in Image Doctor.

Error Message User Remedy

The texture source area needs to be larger for this 
feature size.

Expand the size of your texture source box or decrease the Texture Feature Size.

This host application does not support enough of 
the Photoshop filter specification for this filter to 
run.

Sorry! Your host graphics program is incompatible with Image Doctor. Consult the 
list of compatible host programs in “Host Requirements” on page 2.

This filter requires a selection. Make a selection, then rerun the filter.

This filter requires editable transparency. Please turn 
OFF Preserve Transparency in the Layer palette.

In Photoshop 6 and earlier versions, turn off the Preserve Transparency option in 
the Layers Palette. In Photoshop 7, clear the “Lock Transparent Pixels” button.

This filter only runs on MacOS 9 or later. Check the operating system requirements for Image Doctor in your user manual. 
Image Doctor only works with MacOS 9 or later.

The filter ran out of available memory while render-
ing the preview image.

The solution is to exit our filter, save your image and do the following steps: 

Windows: With Photoshop 5.5 or later, a lot of memory can be taken up with the 
history palette and other features. You can free up this memory by selecting Edit 
> Purge > All from the Photoshop menu.

MacOS X and later: Same solution as Windows. 

MacOS 9: You can increase the memory allocation by exiting Photoshop and per-
forming a Get Info on the Photoshop program icon. With Photoshop 5.5 or later, 
a lot of memory can be taken up with the history palette and other features. You 
can free up this memory by selecting Edit > Purge > All from the Photoshop menu.

A serious error occurred and the filter was unable to 
find the entry point for the core library. Reinstalling 
the filters may fix this problem.

Reinstall Eraser.

A serious error occurred and the filter was unable to 
load the core library. Reinstalling the filters may fix 
this problem.

Reinstall Eraser.

A serious error occurred and the filter was unable to 
set the location of its resources. Reinstalling the fil-
ters may fix this problem.

Reinstall Eraser.

The registration code was not installed or is invalid. 
Please reinstall the filters.

Reinstall Eraser.

Setting names can only include letters, numbers and 
spaces, and must be 31 or fewer characters in length.

Reduce the length of your setting name and make sure that it only contains let-
ters, numbers, or spaces.
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License Agreement

This is a legal agreement (the "Agreement") between you (either an individual or an entity), the end-
user, and Alien Skin Software LLC ("Alien Skin"). By installing the computer software in this package 
("SOFTWARE"), by loading or running the SOFTWARE, or by placing or copying the SOFTWARE onto 
your computer hard drive, you are agreeing to be bound by the terms of this Agreement. If you do 
not agree to the terms of this Agreement, promptly return the SOFTWARE and the accompanying items 
(including all written materials), along with your receipt to the place from where you obtained them 
for a full refund.

ALIEN SKIN LICENSE

1. GRANT OF LICENSE. Alien Skin grants to you the right to use one (1) copy of the enclosed SOFTWARE 
on a single computer. For purposes of this section, "use" means installing the SOFTWARE into RAM, 
as well as installation on a hard disk or other storage device. You may make multiple installations of 
the SOFTWARE on a single computer; provided that, each installation of the SOFTWARE is for use with 
a different application. You may not: rent, lease, distribute, modify, translate, disassemble, 
decompile, reverse engineer, or create derivative works based upon the SOFTWARE. The SOFTWARE, 
together with any archive copy thereof, shall be either returned to Alien Skin or destroyed when no 
longer used in accordance with this Agreement, or when the right to use the SOFTWARE is terminated.

2. COPYRIGHT. The SOFTWARE is owned by Alien Skin and is protected by United States copyright laws 
and international treaty provisions. You must treat the SOFTWARE like any other copyrighted 
material, except that you may either (a) make one copy of the SOFTWARE solely for back-up or 
archival purposes, or (b) transfer the SOFTWARE to a single hard disk provided you keep the original 
solely for back-up or archival purposes. You may not otherwise reproduce, copy or disclose to others, 
in whole or in any part, the SOFTWARE. You may not copy the written materials accompanying the 
SOFTWARE.

3. OTHER RESTRICTIONS. This Agreement is your proof of license to exercise the rights granted herein 
and must be retained by you. You may not rent or lease the SOFTWARE, but you may transfer your 
rights under this License Agreement on a permanent basis provided you transfer this License 
Agreement, the SOFTWARE, and all accompanying written materials and retain no copies, and the 
recipient agrees to the terms of this Agreement. Any transfer of the SOFTWARE must include the most 
recent update and all prior versions. 
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4. GENERAL PROVISIONS. Should any provision of this Agreement be held to be void, invalid, 
unenforceable or illegal by a court, the validity and enforceability of the other provisions shall not 
be affected thereby. If any provision is determined to be unenforceable, you agree to a modification 
of such provision to provide for enforcement of the provision's intent, to the extent permitted by 
applicable law. Failure of a party to enforce any provision of this Agreement shall not constitute or 
be construed as a waiver of such provision or of the right to enforce such provision. If you fail to 
comply with any terms of this Agreement, YOUR LICENSE IS AUTOMATICALLY TERMINATED.

LIMITED WARRANTY

LIMITED WARRANTY. Alien Skin warrants that if properly installed and operated on a computer for 
which it is designed, the SOFTWARE will perform substantially in accordance with the accompanying 
written materials for a period of ninety (90) days from the date of receipt.

CUSTOMER REMEDIES. Alien Skin's entire liability and your exclusive remedy shall be, at Alien Skin's 
option, either (a) return of the price paid or (b) repair or replacement of the SOFTWARE that does not 
meet Alien Skin's Limited Warranty. To make a warranty claim, return the SOFTWARE to the point of 
purchase, accompanied by proof of purchase, your name, your address, and a statement of defect, or 
return the SOFTWARE with the above information to Alien Skin. This Limited Warranty is void if 
failure of the SOFTWARE has resulted in whole or in part from accident, abuse, misapplication or 
violation of this Agreement. Any replacement SOFTWARE will be warranted for the remainder of the 
original warranty period or thirty (30) days, whichever is longer. This warranty allocates risks of 
product failure between you and Alien Skin. Alien Skin's product pricing reflects this allocation of 
risk and the limitations of liability contained in this warranty.

NO OTHER WARRANTIES. ALIEN SKIN DISCLAIMS ALL OTHER WARRANTIES, EITHER EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE WITH RESPECT TO THE SOFTWARE AND THE ACCOMPANYING WRITTEN 
MATERIALS. THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHERS 
WHICH VARY FROM JURISDICTION TO JURISDICTION. ALIEN SKIN DOES NOT WARRANT THAT THE 
OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED, ERROR FREE OR MEET LICENSEE'S SPECIFIC 
REQUIREMENTS. THE WARRANTY SET FORTH ABOVE IS IN LIEU OF ALL OTHER EXPRESS WARRANTIES 
WHETHER ORAL OR WRITTEN. THE AGENTS, EMPLOYEES, DISTRIBUTORS, AND DEALERS OF ALIEN SKIN 
ARE NOT AUTHORIZED TO MAKE MODIFICATIONS TO THIS WARRANTY, OR ADDITIONAL WARRANTIES ON 
BEHALF OF ALIEN SKIN SOFTWARE. ADDITIONAL STATEMENTS SUCH AS DEALER ADVERTISING OR 
PRESENTATIONS, WHETHER ORAL OR WRITTEN, DO NOT CONSTITUTE WARRANTIES BY ALIEN SKIN AND 
SHOULD NOT BE RELIED UPON.
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EXCLUSIVE REMEDIES. You agree that your exclusive remedy against Alien Skin, its affiliates, 
contractors, suppliers, and agents for loss or damage caused by any defect or failure in the SOFTWARE 
regardless of the form of action, whether in contract, tort, including negligence, strict liability or 
otherwise, shall be the return of the purchase price paid or replacement of the SOFTWARE. This 
Agreement shall be construed in accordance with and governed by the laws of the State of North 
Carolina. Copyright and other proprietary matters will be governed by United States laws and inter-
national treaties. IN ANY CASE, ALIEN SKIN SHALL NOT BE LIABLE FOR LOSS OF DATA, LOSS OF 
PROFITS, LOST SAVINGS, SPECIAL, INCIDENTAL, CONSEQUENTIAL, INDIRECT OR OTHER SIMILAR 
DAMAGES ARISING FROM BREACH OF WARRANTY, BREACH OF CONTRACT, NEGLIGENCE, OR OTHER 
LEGAL THEORY EVEN IF ALIEN SKIN SOFTWARE OR ITS AGENT HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY. Some jurisdictions do not allow the 
exclusion or limitation of incidental or consequential damages, so the above limitation or exclusion 
may not apply to you.

VIOLATION OF AGREEMENT. If you breach the provisions of this Agreement, you will be liable to Alien 
Skin for all damages, losses, cash, and expenses incurred by Alien Skin as a result of such breach, 
including lost profits and all the incidental and consequential damages.

U.S. GOVERNMENT RESTRICTED RIGHTS

The SOFTWARE and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or 
disclosure by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the 
Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs 
(c)(1) and (2) of the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as appli-
cable. Contractor/manufacturer is Alien Skin, 1111 Haynes Street, Suite 113, Raleigh, North Carolina 
27604-1305.
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